
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

АВТОМАТИЗАЦИЯ  
ИНЖЕНЕРНЫХ РАСЧЁТОВ 

 
 
 

 

   
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

♦ ИЗДАТЕЛЬСТВО ТГТУ ♦ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 

Министерство образования и науки Российской Федерации 
 

ГОУ ВПО «Тамбовский государственный технический университет» 
 
 
 
 
 
 
 
 
 
 
 
 

АВТОМАТИЗАЦИЯ  
ИНЖЕНЕРНЫХ РАСЧЁТОВ 

 
 

Методические указания по выполнению курсовой работы  
по дисциплине «Информатика» 

для студентов заочной формы обучения специальности 151001  
«Технология машиностроения» 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

Тамбов 
Издательство ТГТУ 

2010 



 

 
УДК   681.3(075) 
ББК    з973-018.2я73-5 
           А224 

 
Рецензент  

 

Кандидат технических наук, доцент ГОУ ВПО ТГТУ  
В.Г. Серёгина 

 
 
 

Составители :  
 

Г.В. Мозгова, М.Ю. Серёгин,  
И.П. Борисов, П.В. Балабанов 

 
 
 
 
 
 
 
 
А224 Автоматизация инженерных расчётов : методические указания 

по выполнению курсовой работы / сост. : Г.В. Мозгова, М.Ю. 
Серёгин, И.П. Борисов, П.В. Балабанов. – Тамбов : Тамб. гос. техн. 
ун-т, 2010. – 40 с. – 50 экз. 
 

 Даны методические указания по применению современных 
прикладных программ, таких как среда автоматизированных 
математических вычислений МathСad и электронных таблиц MS Excel, с 
целью автоматизации инженерных и научных расчётов. Приводится 
подробное описание содержания разделов курсовой работы и примеры 
расчётов. В приложении указаны требования по выполнению и 
оформлению курсовой работы. 

Предназначены для студентов заочного отделения специальности 
151001 «Технология машиностроения». 

 

   УДК   681.3(075) 
ББК    з973-018.2я73-5 

© ГОУ ВПО Тамбовский государственный 
технический университет (ТГТУ), 2010 

 
 

 
 
 
 



 

 
 

Учебное издание 
 

АВТОМАТИЗАЦИЯ ИНЖЕНЕРНЫХ РАСЧЁТОВ 
 

Методические указания 
 
 

Составители: 
 

МОЗГОВА Галина Владимировна,  
СЕРЁГИН Михаил Юрьевич,  
БОРИСОВ Игорь Петрович,  

БАЛАБАНОВ Павел Владимирович 
 
 

Редактор   М.С. Анурьева  
Инженер по компьютерному макетированию   Т.Ю. Зотова  

 
Подписано в печать 11.02.2010 

Формат 60 × 84/16. 2,32 усл. печ. л. Тираж 50 экз. Заказ № 87 
 

Издательско-полиграфический центр  
Тамбовского государственного технического университета 

392000, Тамбов, ул. Советская, 106, к. 14 



 

ВВЕДЕНИЕ 
 
Ещё совсем недавно основными инструментами инженера были калькулятор и чертёжная доска. Расчёты занимали 

немало рабочего времени. Например, большинство инженерных расчётов проводятся в нескольких приближениях, т.е. один 
и тот же алгоритм вычислений повторяется несколько раз, но каждый раз с новыми, уточнёнными данными. Инженер 
вынужден был повторять на калькуляторе вычислительные операции каждого приближения снова и снова. Выполнение 
чертежей также было нелегким занятием. За кульманом (большая чертёжная доска с закреплённой на ней рейсшиной) как 
правило, работали стоя, что приводило к возникновению профессиональных болезней. Так как чертежи выполнялись при 
помощи карандашей различной твёрдости или туши, то неосторожное движение рукой приводило к появлению на чертежах 
грязных разводов и смазанных линий. И нередки были случаи, когда при возникновении ошибки приходилось перечерчивать 
заново весь чертёж. 

К сожалению, на некоторых предприятиях, работающих «по старинке», такая ситуация существует до сих пор. Однако, 
в современных условиях рыночной экономики, такой подход, несомненно, не позволит предприятию быть 
конкурентоспособным и получать прибыль. При размещении заказа на выполнение проектных работ одним из основных 
критериев является минимальное время выполнения проекта. Автоматизация инженерной работы (расчётов, выполнения 
чертежей и текстовых документов) позволяет сократить время выполнения проекта в несколько раз. Для этого требуется 
оборудовать место работы инженера персональным компьютером и установить на него соответствующее программное 
обеспечение. 

Возможности компьютера позволяют использовать его как средство автоматизации инженерной и научной работы. Для 
решения сложных расчётных задач используют программы, написанные специально. В то же время, в инженерной и научной 
работе встречается широкий спектр задач ограниченной сложности, для решения которых можно использовать 
универсальные средства.  

К такого рода задачам относятся:  
- подготовка научно-технических документов, содержащих текст и формулы, записанные в привычной для 

специалистов форме;  
- вычисление результатов математических операций, в которых участвуют числовые константы, переменные и 

размерные физические величины;  
- статистические расчёты и анализ данных;  
- построение двумерных и трёхмерных графиков;  
- дифференцирование и интегрирование, аналитическое и численное;  
- решение дифференциальных уравнений;  
- проведение серий расчётов с разными значениями начальных условий и других параметров; 
- выполнение чертежей.  
К универсальным программам, пригодным для решения таких задач, относятся программы MS Word, MathCad, MS 

Excel. 
MS Word – это мощный текстовый редактор, получивший широчайшее распространение в среде Windows. Он является 

удобным инструментом для подготовки разнообразных текстовых документов, например пояснительных записок, бланков, 
отчётов, инструкций и т.д. 

В основе оформления документов в Word лежит система шаблонов и стилей форматирования, которые позволяют 
достичь единства оформления большинства документов.  

MathCad представляет собой автоматизированную систему, позволяющую динамически обрабатывать данные в 
числовом и аналитическом (формульном) виде. Программа MathCad сочетает в себе возможности проведения расчётов и 
подготовки форматированных научных и технических документов.  

MS Excel – программа, обладающая эффективными средствами обработки числовой информации, представленной в 
виде электронных таблиц. Электронные таблицы обрабатывают числовые данные, которые размещаются в ячейках листа 
Excel. Столбцы и строки таблицы могут иметь текстовые названия. На листе Excel могут также располагаться заголовки, 
подписи и дополнительные ячейки данных с пояснительным текстом.  С помощью Excel можно выполнять сложные 
вычисления с большими массивами чисел, строить диаграммы и печатать финансовые отчёты. 

Курсовая работа на тему «Автоматизация инженерных расчётов» по дисциплине «Информатика» является 
самостоятельной работой, призванной научить студентов использовать в инженерных расчётах современные прикладные 
программы, такие как MS Word, MathCad, MS Excel и преследует следующие цели: 

- сформировать у студентов представление о современных методах и средствах выполнения профессиональных 
обязанностей инженера; 

- дать знания студентам о существующих прикладных компьютерных программах, позволяющих автоматизировать 
инженерную и научную работы; 

- приобрести навыки автоматизированных расчётов в средах Mathcad и MS Excel, оформления текстовых документов 
с использованием текстового процессора MS Word, а также навыки выполнения чертежей с помощью программы AutoCad. 

 
 
 
 
 
 



 

 
СОДЕРЖАНИЕ РАЗДЕЛОВ КУРСОВОЙ РАБОТЫ 

 
Курсовая работа включает в себя расчётно-пояснительную записку, состоящую из двух тем, и графическую часть. 
В расчётно-пояснительную записку по теме 1 «Использование среды Mathcad для расчёта открытой прямозубой 

цилиндрической передачи» входят следующие разделы: 
- введение; 
- задание и исходные данные; 
- описание используемых переменных и функций; 
- расчёт открытой прямозубой цилиндрической передачи в среде MathCad. 
Графическая часть включает в себя чертёж рассчитанной зубчатой цилиндрической передачи, выполненный с помощью 

программы AutoCad. 
В расчётно-пояснительную записку по теме 2 «Использование программы MS Excel для расчёта и построения кривой 

распределения размеров изготавливаемой детали» входят следующие разделы: 
- введение; 
- задание и исходные данные; 
- описание используемых переменных и функций; 
- расчёт и построение кривой распределения размеров изготавливаемой детали. 
Общие разделы расчётно-пояснительной записки: 
- заключение; 
- список использованных источников; 
- приложение. 
Пояснительную записку и графический материал оформлять согласно правилам ЕСКД и ЕСТД. 
 

 
Тема  1 .  ИСПОЛЬЗОВАНИЕ СРЕДЫ MATHCAD ДЛЯ РАСЧЁТА  
ОТКРЫТОЙ ПРЯМОЗУБОЙ ЦИЛИНДРИЧЕСКОЙ ПЕРЕДАЧИ 

 
Введение. В этом разделе следует изложить цели и задачи курсовой работы, указать область применения пакета 

математических вычислений MathCad, значение автоматизированных вычислений для повышения качества инженерных работ. 
Привести обзор существующих программ для автоматизации инженерных и научных вычислений, дать их сравнительную 
характеристику. Литературный обзор допускается проводить с использованием средств INTERNET, при этом обязательны 
ссылки на адреса используемых сайтов (эти адреса должны быть в списке используемых источников). 

Задание и исходные данные. Приводится текст задания и исходные данные из прил. 2 согласно полученному варианту. 
Описание используемых переменных и функций. Все переменные и функции, использованные при расчёте в среде 

MathCad, должны быть описаны в данном разделе.  
Например: 
α – температурный коэффициент сопротивления меди; 
nв – частота вращения вала.  
Расчёт открытой прямозубой цилиндрической передачи в среде MathCad. В этом разделе должна быть приведена 

распечатка расчёта открытой прямозубой цилиндрической передачи, выполненная в программе MathCad.  
Методические указания к выполнению данного раздела.  
Расчёт ведётся в следующей последовательности [3]. 
Определение передаточного числа открытой зубчатой передачи uз.п. Передаточное число uз.п находится из 

зависимости 
 

з.предрем0 uuuu = ,                                         (1.1) 

 
где u0 – общее передаточное число привода, рассчитываемое также по следующей формуле 

в

дв
0 n

n
u = ,                                                (1.2) 

 
где nдв – частота вращения вала электродвигателя, мин–1; nв – частота вращения вала зубчатого колеса, мин–1; uрем – 
передаточное число ременной передачи; uред – передаточное число редуктора. 

Значения nдв, nв, uрем, uред приведены в табл. П2. 
Частота вращения вала шестерни открытой передачи 
 

редрем

дв
1 uu

n
n = .                                            (1.3) 

 



 

Выбор материала для изготовления зубчатых колёс. Производится выбор материала для изготовления зубчатых 
колёс по рекомендациям табл. 1.2. Для изготовления шестерни выбираем улучшенную сталь 45  (НВ 241…285), а для 
изготовления колеса улучшенную сталь 45  (НВ 192…240). 

Расчётная твёрдость: 
–  шестерни  ( )1max1min1 5,0 HBНВНВ +⋅= ; 

–  колеса   ( )2max2min2 5,0 HBНВНВ +⋅= . 

Определение допустимых напряжений изгиба. Допустимые напряжения изгиба рассчитываются по формуле 
 

AN
F

bF
FP YY

S

0
limσ

=σ ,                                       (1.4) 

 
где 0

lim bFσ  – предел выносливости зубьев (по табл. 1.2): 

–  шестерни        1
0

1lim НВ75,1=σ bF ;      (1.5.1) 

–  колеса         2
0

2lim НВ75,1=σ bF ;      (1.5.2) 
SF – коэффициент запаса прочности SF = 1,7 (табл. 1.2); 
YА – коэффициент, учитывающий способ приложения нагрузки: (при одностороннем приложении YА = 1); 

YN – коэффициент долговечности  6 lim

K

F
N N

N
Y = ,         (1.6) 

41 ≤≤ NY ,                                            (1.6.1) 
 

где limFN  – базовое число циклов напряжений (для всех сталей limFN  == 4⋅106); NK – число циклов напряжений в 
соответствии с заданным сроком службы, млн. циклов. Рассчитывается по формуле  

 
hK ncLN 60= , 

 
где n – частота вращения шестерни (для колеса n2 = nв), мин–1; c – число зацеплений зуба за один оборот колеса (с = 1); Lh – 
расчётный ресурс работы передачи, ч 

Если полученные значения YN1 (для шестерни) и YN2 (для колеса) меньше 1, то принимаем YN1 = YN2 = 1. 
Расчёт основных геометрических параметров передачи. Модуль передачи m рассчитывается по формуле 
 

3
1

2
1

1
FS

FPbd

F
m Y

z
KT

Km
σψ

⋅= β ,                                  (1.7) 

 
где Km – расчётный коэффициент, для прямозубых передач Km = 14;  

Т1 – нагрузка на шестерню, 
з.пз.п

2
1 η
=

u
TT , где ηз.п – коэффициент полезного действия открытой зубчатой передачи ηз.п. = 0,95; 

z1 – число зубьев шестерни, z1 = 17…25; z2 – число зубьев колеса, z2 = z1uз.п.; YFS – коэффициент формы зуба, зависящий от 
числа зубьев (табл. 1.1); Ψbd – числовой параметр, для консольного расположения колёс Ψbd = 0,4; KFβ – коэффициент, 
учитывающий неравномерность распределения нагрузки по длине контактной линии и зависящий от параметра Ψbd, для Ψbd 
= 0,4KFβ = 1,4. 
 

Таблица 1.1 
 

z1,2 16 17 20 25 30 40 50 60 80 100 
YFS 4,47 4,28 4,08 3,9 3,8 3,7 3,65 3,62 3,6 3,6 

 
Рассчитанное значение модуля необходимо округлить до ближайшего стандартного значения из ряда: 
1; 1,25; 1,5; 2; 2,5; 3; 3,5; 4; 4,5; 5; 6; 6,5; 8; 10; 12. 
Диаметры делительных окружностей:  
–  шестерни, мм   dw1 = mz1; 
–  колеса, мм   dw2 = mz2. 
Межосевое расстояние передачи, мм  

 
( )215,0 www dda +⋅= .                                      (1.8) 

 
Ширина зубчатого венца, мм 

 
1wbdw db ψ= .                                             (1.9) 



 

 
1.3.5. Проверочный расчёт передачи по напряжениям изгиба. Расчётное местное напряжение при изгибе 

определяют по формуле 
 

FSF
w

t
F YK

mb
F

=σ ,                                       (1.10) 

 
Определим составляющие величины формулы: 

22 /10002 wt dTF =  – окружная сила, Н; 
55,1=FK  – коэффициент нагрузки; 

YFS1 – коэффициент формы зуба шестерни (выбирается из табл. 1.1); 
YFS2 – коэффициент формы зуба колеса (выбирается из табл. 1.1). 

Определяются напряжения изгиба для наиболее слабого элемента по отношению 
FS

FP

Y
σ : 

–  для шестерни 
1

1

FS

FP

Y
σ ; 

–  для колеса 
2

2

FS

FP

Y
σ . 

По рассчитанным значениям определяется наиболее слабый элемент. Если 
1

1

FS

FP

Y
σ <

2

2

FS

FP

Y
σ , то наиболее слабым 

элементом считается шестерня и напряжения изгиба 1Fσ  рассчитываются для шестерни по формуле (1.10). Если 

2

2

FS

FP

Y
σ <

1

1

FS

FP

Y
σ , то наиболее слабым элементом считается колесо и напряжения изгиба 2Fσ  рассчитываются для колеса. 

Рассчитывается степень перегрузки зубчатой передачи 
 

%100⋅
σ

σ−σ
=∆

FPi

FiFPi , 

 
где i = 1, если слабым элементом является шестерня, i = 2, если слабым элементом является колесо. 

Если значение ∆ превышает допустимое значение 5 %, то производится перерасчёт ширины зубчатого венца колёс, мм 
 

w
FPi

Fi
w bb

σ
σ

=′ ,                                          (1.11) 

 
где i = 1, если слабым элементом является шестерня, i = 2, если слабым элементом является колесо. 

Расчёты п. 1.3.5 повторяются с новым значением ширины зубчатого венца колёс bw. 
Расчёт диаметров окружностей. Рассчитываются диаметры окружностей вершин зубьев 
–  шестерни, мм  mdd wa 211 += ;    (1.12.1) 
–  колеса, мм   mdd wa 222 += .    (1.12.2) 
 
Рассчитываются диаметры окружностей впадин зубьев 
–  шестерни, мм  mdd wf 5,211 −= ;   (1.13.1) 

–  колеса, мм   mdd wf 5,222 −= .   (1.13.2) 

Построение графика функции f(x). Способ построения графика функции в среде MathCad описан в прил. 5.2. 
Основные функции и приёмы работы в среде MathCad приведены в прил. 5. 
По рассчитанным геометрическим размерам вычерчивается схема зубчатой цилиндрической передачи с применением 

программы AutoCAD (или любого другого доступного графического редактора). Лист чертежа, оформленный по правилам 
ЕСКД (Единой системы конструкторской документации) помещается в прил. 1 к пояснительной записке курсовой работы. 
Пример чертежа представлен на рис. 1.1. 



 

 
 

Рис. 1.1. Зубчатая цилиндрическая передача 
 
Справочные данные.  

 
1.2. Приближённые значения 0

limbFσ , Yв, Yd, SF (ГОСТ 21354–87) 
 

Сталь 

Способ 
термической или 
термохимической 

обработки 

Твёрдость 
активной 
поверхност
и зубьев 

0
limbFσ , 

МПа 
Yв Yd SF

Углеродистая и легированная, содержащая 
более 0,15 % углерода(например,  
марок 40, 45 по ГОСТ 1050–88, марок 40Х, 
40ХН, 40ХФА, 40ХН2МА, 18Х2Н4ВА по 
ГОСТ 4543–71*) 

Нормали-зация, 
улучшение 

180…350 
НВ 1,75 1,1 1,1…1,3 1,7

Легированные стали, содержащие 
0,4…0,55 % углерода  
(40Х, 40ХН  
и другие по  
ГОСТ 4543–71*) 

Объёмная закалка 
с применением 
средств против 

обезуглероживани
я 

40…55 
HRC 580 75,0

9,0  2,1...1,1
15,1...05,1

 
1,7

Легированные, содержащие  
более 1 % никеля (40ХН, 50ХН  
и другие по  
ГОСТ 4543–71*) 

Объёмная закалка 
при возможном 

обезуглероживани
и 

45…55 
HRC 500 

8,0
1  

2,1...1,1
3,1...1,1  1,

7 

Прочая  
легированная (марок 40Х, 40ХФА  
и другие по  
ГОСТ 4543–71*) 

Объёмная закалка 
при возможном 

обезуглероживани
и 

45…55 
HRC 460 

8,0
1  

2,1...1,1
3,1...1,1  1,

7 

Содержащая алюминий. 
Прочая  
легированная Азотиро-вание 

700…950 
HV 

550…750 
HV 

290 – 1 1,
7 

Легированная сталь всех  
марок 

Цементация  
в средах с 

неконтролируемым 
углеродным 
потенциалом  
и закалке с 
применением 

средств  
против  

обезуглеро-живания,
достигается 
содержание 
углерода на 
поверхности 
0,4…1,4 % 

56…63 
HRC 800 

65,0
8,0  

3,1...15,1
2,1...1,1  1,

65

Легированные стали, не  
содержащие  
молибден  
(марок 25ХГТ, 30ХГТ, 35Х  
и другие по  
ГОСТ 4543–71*) 

Нитроцементация 57…63 
HRC 750 0,75 

35,1...1,1
1,1...05,1  1,

55



 

Тема  2. ИСПОЛЬЗОВАНИЕ ПРОГРАММЫ MS EXCEL  
ДЛЯ РАСЧЁТА И ПОСТРОЕНИЯ КРИВОЙ РАСПРЕДЕЛЕНИЯ РАЗМЕРОВ ИЗГОТАВЛИВАЕМОЙ ДЕТАЛИ 

 
Введение. В этом разделе следует указать область применения программы MS Excel. Указать на возможности данной 

программы, приводящие к её широчайшему использованию на предприятиях и в организациях. Литературный обзор 
допускается проводить с использованием средств INTERNET, при этом обязательны ссылки на адреса используемых сайтов 
(эти адреса должны быть в списке используемых источников). 

Задание и исходные данные. Приводится текст задания и исходные данные из прил. 3 согласно полученному варианту. 
Описание используемых переменных и функций. Все переменные и функции, использованные при расчёте, должны 

быть описаны в данном разделе.  
Например: 
dmin – минимальный измеренный диаметр вала; 
dmax – максимальный измеренный диаметр вала. 
Расчёт и построение кривой распределения размеров изготавливаемой детали. В этом разделе должна быть 

приведена распечатка листов рабочей книги MS Excel с проведёнными расчётами, согласно варианту, состоящая из трёх 
листов: 

1 лист – расчётная таблица, 
2 лист – гистограмма и полигон распределения размеров, 
3 лист – кривая нормального распределения размеров. 
Методические указания к выполнению данного раздела. 
Теоретические сведения [4]. При изготовлении деталей невозможно достичь абсолютно точных номинальных 

размеров. В связи с этим при составлении рабочих чертежей деталей назначаются допустимые отклонения от номинальных 
значений, которые отвечают требованиям точности их изготовления. Точность выполняемых размеров характеризуется 
полями допусков. К факторам, определяющим возможность возникновения погрешностей при механической обработке, 
относят: точность станков, инструментов, приспособлений; жёсткость технологической системы, погрешность установки 
заготовки и др. Все элементарные погрешности при механической обработке можно разделить на систематические и слу-
чайные. 

Рассматриваемый метод основан на выполнении определённой партии заготовок с контролем интересующего 
параметра. Результаты замеров математически обрабатываются. По полученным данным строят кривую распределения 
исследуемого размера. 

Опытная кривая распределения начинается строиться с выявления предельных значений в полученном ряде размеров. 
Поле рассеяния ∆р определяют по разности между наибольшим dmax и наименьшим dmin размерами заготовок в партии 

minmax ddp −=∆ .                                          (2.1) 
 

Полученное значение разбивают на k равных интервалов, определяя частоту mi(x) попадания деталей соответствующих 
размеров в каждый интервал 

 

n
mxm i

i =)( ,                                              (2.2) 

 
где mi – число заготовок, фактический размер которых попадает в пределы данного интервала; n – общее число деталей в 
партии. 

При этом ширина каждого интервала w определяется как  
 

k
dd=w minmax − ,                                          (2.3) 

 
а значение величины интервала округляется до третьего знака. 

Границы интервалов определяются следующим образом. 
1-й интервал:  нижняя граница min1 xx = ,  

верхняя граница wxx += min2,1 . 
2-й интервал:  нижняя граница 2,1x ,  

верхняя граница w+w+xx min3,2 = . 
3-й интервал:  нижняя граница 3,2x ,  

верхняя граница w+w+xx 2min4,3 = , 
и т.д., в зависимости от количества заданных интервалов k. 

Для каждого из интервалов определяется значение середины Xi . Считается, что размер, определяющий верхнюю 
границу интервалов, принадлежит только i + 1 интервалу. Так как, значение величины округляется до третьего знака, то 
значение верхней границы предыдущего интервала берётся на 0,001 меньше нижней границы, следующего интервала. 
Следовательно, значение середины соответствующего интервала (1-го, 2-го, 3-го и т.д.) рассчитывается следующим образом: 
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По полученным данным строится гистограмма распределения и полигон распределения размеров, совмещённые на 

одной диаграмме.  
Гистограмма распределения представляет собой ступенчатый график, состоящий из прямоугольников, ширина, которых 

равна значению интервала, а высота частотам значения случайной величины в своём интервале, а полигон распределения 
ломанную экспериментальную кривую, соединяющую середины интервалов (рис. 2.7). 

При построении по оси абсцисс откладывают интервалы размеров заготовок ix , а по оси ординат – частоту их 
повторения )(xm . Исходя из условий задания и принимая во внимание, что большинство случайных погрешностей 
подчиняется закону Гаусса, строится кривая нормального распределения (рис. 2.8), которая отвечает условию 
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2

2
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2
1 σ
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⋅
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где σ – среднеквадратичное отклонение аргумента: π = 3,14; e = 2,718 – основание натурального логарифма; срX  – среднее 

арифметическое данных измерений. 
Среднеквадратичное отклонение σ определяют по результатам измерений партии заготовок по формуле  

 

∑ ⋅−
n
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n
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1

2
ср )(1σ ,    (2.6) 

где n – общее число произведённых измерений;  
 

k

mX
=X

n

i
ii∑
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ср .         (2.7) 

 
Пример выполнения задания. 
 
Исходные  данные :  
Диаметр обрабатываемого вала  50=d мм 
Наименьший размер    mind = 49,61мм 
Наибольший размер    maxd = 50 мм 
Объем выборки     n = 50 шт. 
Число размерных групп    k = 6 
 
Количество деталей, попавших в ту или иную размерную группу, определяется по табл. П3.2 прил. 3 согласно варианту 

задания. 
№ интервала; d = 50, n = 50 

№ варианта 
1 2 3 4 5 6 

im  0 
3 9 8 14 9 7 

 
В начале работы необходимо создать документ приложения Excel, который называется книгой. Такая книга состоит из 

листов, представляющих собой большие таблицы ячеек с числами и текстовой информацией. 
Выполнение задания начинается с построения расчётной таблицы, примерный вид которой показан на рис. 2.1. 



 

Построение расчётной таблицы начинается с заполнения названия строк в первом столбце, как показано на рис. 2.1. 
Чтобы ввести информацию в рабочую таблицу, поместите табличный курсор в нужную ячейку, а затем введите в неё свои 
данные  

 

 
 

Рис. 2.1. Расчётная таблица 
. Как только вы начнёте вводить информацию в режиме Ввод, все символы будут появляться сразу в двух местах: в 
выбранной ячейке и в строке формул, которая находится вверху экрана над заголовками столбцов. Чтобы завершить ввод 
данных и перевести Excel из режима Ввод в режим Готово, щёлкните на кнопке Ввод, нажмите <Enter> или одну из клавиш 
со стрелками для перехода в другую ячейку. В случае, если текст не помещается в ячейке, Excel отрежет лишний текст по 
границе ячейки, при этом не удаляя эти символы из ячейки. 

Для того, чтобы недостающий фрагмент текста снова появился на экране, нужно расширить соответствующий столбец. 
Установить ширину столбцов можно с помощью диалогового окна <Ширина столбца>, для этого необходимо ввести 
количество символов, которое должно поместиться в столбце. Чтобы открыть это диалоговое окно, в контекстном меню 
столбца (открывающемся после щелчка правой кнопкой мыши на любом выбранном столбце или его букве) выберите команду 
Ширина столбца либо команду Формат – Столбец – Ширина – Ширина столбца. Высота строки устанавливается 
подобным образом при помощи диалогового окна <Высота строки>. 

При заполнении таких граф, как mind  и maxd  потребуется объединить ячейки. Для этого объединяемые ячейки 
необходимо выделить перемещением табличного курсора или переводом Excel в режим выделения, нажав клавишу F8, после 
чего нажатием любой клавиши управления курсором, его можно передвигать, автоматически выделяя нужные ячейки. С 
помощью диалогового окна <Формат ячеек> выделенные ячейки можно объединить. Чтобы открыть это диалоговое окно, в 
контекстном меню нужно выбрать команду Формат ячеек, и поставить флажок в строке <объединение ячеек>. 

После заполнения граф таблицы с исходными данными, можно перейти к заполнению соответствующих ячеек 
расчётными формулами. 

Определение поля рассеяния размеров и ширины интервалов. Поле рассеяния размеров и ширину интервалов 
рассчитывается по формулам (2.1) и (2.3). При этом значение ширины интервала округляется до третьего знака. 

О том, что в текущую ячейку вводится формула (а не текст или число), говорит знак равенства <=> перед первым 
символом формулы. За знаком равенства следует либо встроенная функция, например СУММ или СРЗНАЧ, либо ряды 
чисел или координаты ячеек (содержащих значения), разделённые одним или несколькими из перечисленных ниже 
математических операторов. 

+  (плюс) – сложение; 
-  (минус) – вычитание; 
*  (звёздочка) – умножение; 
/  (косая черта) – деление; 
^  (знак вставки) – возведение в степень. 
Если в формуле используются вложенные скобки, то необходимо проверять, чтобы число открывающихся скобок было равно 

числу закрывающихся. Если не закрыть хотя бы одну пару скобок, при попытке ввести такую формулу появится диалоговое окно 
с предупреждением об ошибке во введённом выражении. Также возможно получение неверного результата ввиду того, что Excel 
выполняет каждую операцию в порядке слева направо, руководствуясь приоритетом операций – умножение и деление имеют 
более высокий приоритет, чем сложение и вычитание, и, следовательно, выполняются первыми. 



 

Исходя из структуры таблицы на рис. 2.1, занесём в строку 6 расчётную формулу (2.3) для вычисления ширины 
интервала. Для этого вначале присвоим значениям mind  и maxd  имена, соответственно dmin и dmax, а строке 6 (рис. 2.2) имя 
W, используя диалоговое окно <Присвоение имени>, для чего необходимо выделить нужные ячейки и выбрать команду 
Вставка – Имя – Присвоить. 

Присвоенные имена ячеек используются в формуле 
 

=(dmax – dmin)/6. 
 

Подобным образом присваивается имя n объёму выборки в строке 3. 
Расчёт значения частоты распределения размеров )(xmi . Для определения значения частоты распределения 

размеров )(xmi  в каждом интервале (в ячейках В9-G9 на рис. 2.1) используется формула (2.2). 
Для первого интервала в ячейке В9 надо записать формулу (2.2) в следующем виде 

=B5/n. 
 

Для второго интервала в ячейке С9 соответственно 
 

=С5/n 
 
и подобным образом для всех оставшихся интервалов. 
 

 
 

Рис. 2.2. Диалоговое окно <Присвоение имени> 
Для более быстрого и удобного ввода формул в ячейки, в данном случае удобно воспользоваться средствами 

автозаполнения. При этом достаточно ввести первый элемент ряда, например формулу в ячейку В9 и средство 
автозаполнение продолжит ряд, когда вы переносите указатель заполнения вправо (по строке) или вниз (по столбцу). Маркер 
заполнения выглядит как маленький чёрный крестик (+) и появляется только при помещении указателя мыши в правый 
нижний угол ячейки (или на последнюю ячейку выбранного блока). Во время перемещения мыши программа информирует о 
том, что будет введено в последнюю выбранную в диапазоне ячейку, отображая эту информацию рядом с указателем мыши. 
Когда, расширив диапазон с помощью указателя заполнения, вы отпустите кнопку мыши, Excel либо создаст 
последовательность элементов во всех выбранных вами ячейках, либо заполнит весь диапазон начальным элементом. 

После того как вы введёте формулу =B5/n в ячейку В9 рабочей таблицы, результат вычислений в ней будет зависеть от 
текущих значений в ячейках В5 и ячейки с именем n. Особенность электронных таблиц заключается в способности формул 
автоматически пересчитывать результаты в соответствии с изменениями в ячейках, координаты которых используются в 
формуле. 

В ячейке Н9 необходимо отобразить сумму частот распределения размеров во всех интервалах. Для этого, нужно 
выделить ячейку Н9 и  воспользоваться диалоговым окном <Мастер функций>, показанным на рис. 2.3, выбрав команду 
Вставка – Функция. В диалоговом окне <Мастер функций> нужно выбрать команду СУММ, или просто записать в 
ячейку Н9 формулу в виде 

 
=СУММ(B4:G4), 

 
где (B4:G4) – диапазон суммируемых ячеек. 
 



 

 
 

Рис. 2.3. Диалоговое окно <Мастер функций> 
Расчёт значений середин и границ интервалов. Следуя методическим указаниям, находим границы интервалов и 

определяем середину каждого из них. Так как значение нижней границы первого интервала x1 = xmin должно располагаться в 
ячейке В8, то запишем в эту ячейку формулу 
 

=dmin. 
 

Значение верхней границы первого интервала, являющееся одновременно значением нижней границы второго 
интервала должно располагаться в ячейке С8. Для этого в ячейку С8 запишем 

 
=B8+W, 

 
где В8 – номер ячейки, хранящей значение предыдущей границы; W – имя присвоенное ячейке со значением ширины 
интервала. 

Ячейки D8 – H8 заполняем аналогично, используя средство автозаполнения. 
Расчёт значений середин интервалов Xi (располагающихся в ячейках В10 – G10) проведём по формулам (2.4), 

записанным в соответствующие ячейки в виде: 
–  для первого интервала, ячейка В10 
 

=(B8+(C8-0,001))/2; 
 
–  для второго интервала, ячейка С10 
 

=(C8+(D8-0,001))/2 
и т.д.  

Построение гистограммы и полигона частот распределения размеров. На основании значений )(xmi  и значений 
середин интервалов Xi, необходимо построить гистограмму и полигон частот распределения размеров. 

Модуль диаграмм приложения Excel автоматически генерирует диаграммы, отображающие общие данные листа в 
графической форме. Остается только выбрать нужный диапазон ячеек и указать тип диаграммы. Перед вызовом мастера 
диаграмм выделите диапазон ячеек, информация в которых должна использоваться при создании диаграммы. Необходимо 
иметь в виду, что для достижения желаемых результатов информацию нужно представить в виде сплошной таблицы – тогда 
её можно выделить как единый диапазон (рис. 2.4). При создании диаграммы, в которой используются оси X и Y (как и в 
большинстве диаграмм), мастер диаграмм обычно берёт заголовки столбцов выделенной таблицы для проставления меток по 
оси X. Excel выводит независимую переменную по оси X, а зависимое значение – по оси Y. Если таблица имеет заголовки 
строк, мастер использует их для обозначения переменных (если вы захотите их включить). Легенда (обозначение) 
идентифицирует каждую точку, столбец и полоску в диаграмме, представляющие значения переменных. 

Рассмотрим подробно использование мастера диаграмм на примере построения гистограммы распределения размеров 
(рис. 2.7).  

Выделим диапазон ячеек в строке 9, а именно частоту попадания размеров в интервал, как показано на рис. 2.4 и 
выполним следующие действия. 

1. Щёлкните на кнопке Мастер диаграмм ( ) панели инструментов, чтобы открыть диалоговое окно <Мастер 
диаграмм>, вкладка Стандартные.  

2. Выберите нужный тип диаграммы. В данном примере выбираем гистограмму. Чтобы увидеть выделенные данные в 
виде диаграммы выбранного типа, щёлкните (и придержите кнопку мыши) на кнопке Просмотр результата в нижней части 
диалогового окна (рис. 2.4). 

3. Щёлкните на кнопке Далее, чтобы открыть шаг 2 диалогового окна <Мастер диаграмм> – источник данных 
диаграммы (рис. 2.5). 

Это диалоговое окно позволяет изменить диапазон данных, на основе которых должна быть построена диаграмма (или 
определить его, если это ещё не сделано), а также указать, как представлены ряды данных в этом диапазоне. Если 
потребуется изменить диапазон ячеек, то это можно сделать в поле Диапазон. 

Внесём изменения в заголовке выбранного диапазона. Для этого нужно перейдите на вкладку Ряд. В поле Имя введём 
название графика, а в поле Подписи по оси Х – диапазон середин интервалов, выделив ячейки В10 – G10. 



 

 

 
 

Рис. 2.4. Построение диаграммы (шаг 1 из 4) 

 
 

Рис. 2.5. Построение диаграммы (шаг 2 из 4) 
 
4. Щёлкните на кнопке Далее, чтобы открыть шаг 3 диалогового окна <Мастер диаграмм> – параметры диаграммы. 

Это диалоговое окно (рис. 2.6) позволяет установить множество параметров, определяющих, например, заголовки, линии 
сетки, подписи рядов и таблица со значениями, на основе которых была создана диаграмма. В зависимости от параметров, 
которые нужно изменить, перейдите на соответствующую вкладку и внесите изменения. 

 

 
 

Рис. 2.6. Построение диаграммы (шаг 3 из 4) 



 

5. Щёлкнув на кнопке Далее откроется шаг 4 диалогового окна <Мастер диаграмм> – размещение диаграммы. Это 
диалоговое окно позволяет поместить новую диаграмму либо на собственном листе в рабочей книге, либо в качестве 
графического объекта на одном из существующих листов рабочей книги. Для помещения диаграммы на отдельном листе 
установим переключатель Отдельном и введём новое имя листа. 

Для построения полигона распределения вызовем контекстное меню на поле диаграммы и воспользуемся строкой 
исходные данные. Во вкладке Ряды добавим второй ряд и присвоим ему имя Полигон распределения в поле Имя. В поле 
Значения выберем диапазон ячеек В10-G10, выделив его. Приняв результаты, теперь необходимо изменить тип графика с 
именем Полигон распределения. Для этого выделим его и вызовем контекстное меню – тип диаграммы. Для полигона 
распределения примем тип диаграммы – график с маркерами, помечающие точки данных. 

Получившаяся гистограмма и полигон распределения размеров показаны на рис. 2.7. 
 

 
 

Рис. 2.7. Гистограмма и полигон распределения размеров 
 
Построение кривой нормального распределения. Для расчёта среднеарифметического значения размера Xср ячейке в 

строке 11 (рис. 2.1) присваиваем имя, например Xs, и задаём формулу расчёта (2.7) в виде 
 

=СУММ(B10:G10)/6 
Значение среднеквадратического отклонения σ будет находиться в ячейке В12, которой присвоим имя, например bs. 

Расчёт ведётся по формуле (2.6), записанной в виде 
 

=КОРЕНЬ((B6*(B10-B11)^2+C6*(C10-B11)^2+D6*(D10- 
-B11)^2+E6*(E10-B11)^2+F6*(F10-B11)^2+G6*(G10-B11)^2)/n) 

 
Используя (2.5) вычисляем значения ординат кривой Гаусса и строим кривую нормального распределения (рис. 2.8). 

Формулы для вычисления заносим в ячейки В13-G13.  
Для первого интервала – ячейка В13  

 
=1/(bs*КОРЕНЬ(2*ПИ())*EXP(-(В10-Xs)^2/(2*bs^2))) 

 
Аналогично заполняем остальные ячейки, используя автозаполнение.  

Кривую нормального распределения строим на отдельном листе  книги способом описанным выше. В качестве 
диапазона выбираем ячейки В13 – G13, в качестве типа диаграммы – точечную диаграмму. 

 



 

 
 

Рис. 2.8. Кривая нормального распределения 
 
Заключение. В данном разделе перечисляются полученные знания и навыки в процессе выполнения курсовой работы, 

а также возможность их применения в конкретной профессиональной области работы студента. 
Список использованных источников. Список использованных источников должен быть составлен в соответствии с 

требованиями ГОСТ 7.1–2003 Библиографическая запись. Библиографическое описание. Общие требования и правила 
составления. 

В списке необходимо указать все источники, на которые по тексту пояснительной записки имеются ссылки. 
Приложение. Приложение 1 включает в себя чертёж рассчитанной зубчатой цилиндрической передачи по теме 1, 

выполненный с помощью программы AutoCad (или любого другого доступного графического редактора). 
Приложение 2 включает в себя CD-диск с выполненными заданиями по темам 1 (в среде MathCad) и 2 (в MS Excel). 

Диск обязательно должен быть подписан с указанием фамилии автора курсовой работы, варианта, группы и года сдачи 
курсовой работы. 

Диск должен быть помещён в конверт и прикреплён к пояснительной записке. 
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Приложение 1 
 

ТРЕБОВАНИЯ К ОФОРМЛЕНИЮ И СОДЕРЖАНИЮ  
КУРСОВОЙ РАБОТЫ 

 
1. Курсовая работа выполняется в печатном виде на листах формата А4 с рамками.  
2. Курсовая работа должна быть помещена в скоросшиватель (пластиковый) или скреплена степлером. Другие способы 

скрепления не допускаются! Не допускается помещать листы курсовой работы в отдельные пластиковые файлы! 
3. На обложке курсовой работы размещается этикетка, затем титульный лист и лист задания. Примеры оформления 

листов находятся в приложении 4. 
4. На листе «Содержание» размер штампа должен составлять  40 × 185 мм, на листах пояснительной записки – 15 × 185 

мм, на чертежах угловой штамп выполняется в обычном размере – 55 × 185 мм. 
5. К курсовой работе обязательно должен прилагаться CD-диск с программами расчёта в среде MathCad и MS Excel. 

Диск должен быть подписан с указанием фамилии автора курсовой работы, варианта, группы и года сдачи курсовой работы.  
 

ВАЖНО! 
При невыполнении требований к оформлению курсовая работа не рецензируется и возвращается студенту для 

последующей доработки. 
 

Приложение 2 
 

ЗАДАНИЕ ПО ТЕМЕ 1 
 

С использованием математического процессора MathCad рассчитать открытую прямозубую цилиндрическую передачу 
лопастного вала смесителя и проследить изменение некоторой функции f в зависимости от изменения величины x (построить 
график функции f(x)). 

Привод состоит из: электродвигателя с частотой вращения вала nдв; ременной передачи с передаточным числом uрем; 
редуктора с передаточным числом uред. Вращающий момент на валу зубчатого колеса открытой передачи Т2, частота вращения 
вала nв. Ресурс работы открытой передачи Lh. Число зубьев шестерни z1. 

По рассчитанным геометрическим размерам вычертить схему зубчатой цилиндрической передачи с применением 
программы AutoCAD (или любого другого доступного графического редактора). 

П2. Варианты заданий по теме 1 
 

№ 
вар. 

Т2,
кН⋅м

nв, 
мин–1 

nдв, 
мин–1 uрем uред Lh, ч z1 f(x) Диапазон 

изменения x 

1 26,5 3,7 1460 2 36 20 000 22 aw(z1) 17…25 

2 25,5 3,2 1390 2,24 35 15 000 17 ∆(T2) 20…30, кН⋅м 

3 21,0 2,8 1420 2,5 34 10 000 18 da1(z1) 17…25 

4 20,5 2,7 1415 2,8 30 25 000 19 da2(z2) 90…140 

5 22,0 2,9 1425 3,15 32 30 000 20 df1(z1) 17…25 

6 23,5 3,1 1435 2 33 20 000 21 df2(z2) 90…140 

7 23,0 3,0 1430 2,24 34 15 000 23 m(T1) 5…20, кН⋅м 

8 27,5 4,3 1445 2,5 37 10 000 24 YN1(Lh) 10 000…30 000, ч 

9 21,5 2,7 1455 2,8 31 25 000 25 YN2(Lh) 10 000…30 000, ч 

10 20,0 2,5 1460 3,15 30 30 000 17 T1(nв) 2,5…4,5, мин–1 

11 28,0 3,8 1448 2 40 20 000 18 aw(z1) 17…25 

12 29,5 4,4 1470 2,24 42 15 000 19 ∆(T2) 20…30, кН⋅м 

13 27,0 3,7 1462 2,5 36 10 000 20 m(T1) 5…20, кН⋅м 



 

14 22,5 3,0 1395 2,8 33 25 000 22 T1(nв) 2,5…4,5, мин–1 

15 24,5 3,8 1432 3,15 34 30 000 25 aw(z1) 17…25 

 
 
 

Приложение 3 
 

ЗАДАНИЕ ПО ТЕМЕ 2 
 

На токарном станке обрабатывается партия валов диаметром d, состоящая из 400 шт. По результатам замеров n шт. 
пробных заготовок получены наименьший размер mind ,и наибольший maxd . Принимая, что распределение размеров 
подчиняется закону нормального распределения Гаусса, необходимо: 

– разбить распределение размеров на k интервалов, определив границы каждого из них; 
– определить частоту попадания размеров в каждый из интервалов; построить гистограмму и полигон распределения 

размеров; 
– определить среднеквадратичное отклонение σ, исходя из результатов измерения заготовок; 
– построить опытную кривую нормального распределения y = F(x). 
Порядок расчёта и полученные данные последовательно изобразить в виде расчётной таблицы в Microsoft Office Excel. 

Диаграммы выполнить на отдельных листах. 
 

П3.1. Варианты заданий по теме 2 
 

Диаметр вала, мм. 
№ п/п 

Объём  
выборки n, 

шт. d dmin dmax 

Число 
размерных 
групп k 

1 49,65 50,07 6 
2 49,5 49,9 8 
3 49,7 50,2 10 
4 49,5 50,1 12 
5 

70 50 

49,7 49,8 14 
6 69,5 70,1 6 
7 69,56 70 8 
8 69,7 70,2 10 
9 69,8 70,1 12 

10 

100 70 

69,51 70 14 
11 89,46 90 6 
12 89,6 90,4 8 
13 89,5 89,8 10 
14 89,2 89,8 12 
15 

150 90 

89,5 90,2 14 
 

П3.2. Распределение деталей по размерным группам ki 
 

Размерная группа ki № 
вар. 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 6 11 18 14 11 10         
2 10 5 13 10 10 5 14 3       
3 4 5 10 10 15 4 10 7 3 2     
4 3 3 6 6 14 7 4 7 7 6 4 3   
5 2 2 10 1 7 6 10 8 5 8 4 2 3 2 
6 8 20 18 28 11 15         
7 11 10 15 20 14 7 15 8       
8 7 8 11 18 20 7 7 10 8 4     
9 3 3 7 6 23 9 10 18 8 6 4 3   

10 2 2 7 8 11 10 24 8 5 8 8 2 3 2 



 

11 10 20 50 20 35 15         
12 14 13 30 20 14 33 17 9       
13 7 8 17 18 30 15 26 18 7 4     
14 4 6 11 8 20 25 21 18 8 17 7 5   
15 3 3 14 8 22 10 10 11 5 25 10 13 7 9 

 
 

Приложение 4 
 

ПРИМЕР ОФОРМЛЕНИЯ ЭТИКЕТКИ, ТИТУЛЬНОГО ЛИСТА  
И ЛИСТА ЗАДАНИЯ НА КУРСОВУЮ РАБОТУ 

 
Пример оформления этикетки курсовой работы 

 
 
 
 
 
 
 
 
 
 
 

ТГТУ. 151001. 001 
Кафедра АСП 

КУРСОВАЯ РАБОТА 
по дисциплине «Информатика» 

на тему 
«Автоматизация инженерных расчётов» 

 
Иванов И.И., группа Т–21з 

 
Тамбов 201__ г. 



 

 
Пример оформления титульного листа курсовой работы 
 
 
 
 
 
 



 

 
 
 

 



 

 
 

Приложение 5 
 

П5.1. ОСНОВНЫЕ ФУНКЦИИ МАТЕМАТИЧЕСКОГО  
ПРОЦЕССОРА MATHCAD [1] 

 
Научно-технические документы обычно содержат формулы, результаты расчётов в виде таблиц данных или графиков, 

текстовые комментарии или описания, другие иллюстрации. В программе MathCad им соответствуют два вида объектов: 
формулы и текстовые блоки. Формулы вычисляются с использованием числовых констант переменных, функций 
(стандартных и определённых пользователем), а также общепринятых обозначений математических операций. Введённые в 
документ MathCad формулы автоматически приводятся к стандартной научно-технической форме записи. Графики, которые 
автоматически строятся на основе результатов расчётов, также рассматриваются как формулы. Комментарии, описания и 
иллюстрации размещаются в текстовых блоках, которые игнорируются при проведении расчётов. 

Чтобы буквенные обозначения можно было использовать при расчётах по формулам, этим обозначениям должны быть 
сопоставлены числовые значения. В программе MathCad буквенные обозначения рассматриваются как переменные, и 
значения задаются при помощи оператора присваивания (обозначается символом «:=»).  

Таким же образом можно задать числовые последовательности, аналитически определённые функции, матрицы и 
векторы.  

Если все значения переменных известны, то для вычисления числового значения выражения (скалярного, векторного 
или матричного) надо подставить все числовые значения и произвести все заданные действия. В программе MathCad для 
этого применяют оператор вычисления (вводится символом «=»). В ходе вычисления автоматически используются значения 
переменных и определения функций, заданные в документе ранее. Удобно задать значения известных параметров, провести 
вычисления с использованием аналитических формул, результат присвоить некоторой переменной, а затем использовать 
оператор вычисления для вывода значения этой переменной.  

Например:  
g:=9.8  
М:=3 
F:=M·g 
F = 29.4  
Изменение значения любой переменной, коррекция любой формулы, означает, что все расчёты, зависящие от этой 

величины, необходимо проделать заново. Программа MathCad автоматически производит необходимые вычисления, 
обновляя изменившиеся значения и графики.  

П5.2. ПРИЁМЫ РАБОТЫ С СИСТЕМОЙ MATHCAD [2] 
 

Документ программы MathCad называется рабочим листом. Он содержит объекты: формулы и текстовые блоки. В ходе 
расчётов формулы обрабатываются последовательно, слева направо и сверху вниз, а текстовые блоки игнорируются.  

Ввод информации осуществляется в месте расположения курсора. Программа MathCad использует три вида курсоров. 
Если ни один объект не выбран, используется крестообразный курсор, определяющий место создания следующего объекта. 
При вводе формул используется уголковый курсор, указывающий текущий элемент выражения. При вводе данных в 
текстовый блок применяется текстовый курсор в виде вертикальной черты.  

Ввод формул. Формулы – основные объекты рабочего листа. Новый объект по умолчанию является формулой. Чтобы 
начать ввод формулы, надо установить крестообразный курсор в нужное место и начать ввод букв, цифр, знаков операций. 
При этом создаётся область формулы, в которой появляется уголковый курсор, охватывающий текущий элемент формулы, 
например имя переменной (функции) или число. При вводе бинарного оператора по другую сторону знака операции 
автоматически появляется заполнитель в виде чёрного прямоугольника. В это место вводят очередной операнд.  

Для управления порядком операций используют скобки, которые можно вводить вручную. Уголковый курсор позволяет 
автоматизировать такие действия. Чтобы выделить элементы формулы, которые в рамках операции должны рассматриваться 
как единое целое, используют клавишу ПРОБЕЛ. При каждом её нажатии уголковый курсор расширяется, охватывая 
элементы формулы, примыкающие к данному. После ввода знака операции элементы в пределах уголкового курсора 
автоматически заключаются в скобки.  

Элементы формул можно вводить с клавиатуры или с помощью специальных панелей управления. Панели управления 
(рис. П5.1) открывают с помощью меню View (ВИД) или кнопками панели управления Math (Математика). Для ввода 
элементов формул предназначены следующие панели:  

- панель управления Calculator (Счёт) для ввода чисел, знаков типичных математических операций и наиболее часто 
употребляемых стандартных функций;  

- панель управления Evaluation (Вычисление) для ввода операторов вычисления и знаков логических операций;  
- панель управления Graph (График) для построения графиков;  
- панель управления Matrix (Матрица) для ввода векторов и матриц и задания матричных операций;  
- панель управления Calculus (Исчисление) для задания операций, относящихся к математическому анализу;  
- панель управления Greek (Греческий алфавит) для ввода греческих букв;  
- панель управления Symbolic (Аналитические вычисления) для управления аналитическими преобразованиями.  
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Рис. П5.1. Панели инструментов программы MathCad 

 
Введённое выражение обычно вычисляют или присваивают переменной. Для вывода результата выражения используют 

знак вычисления, который выглядит как знак равенства и вводится при помощи кнопки Evaluate Expression (Вычислить 
выражение) на панели инструментов Evaluation (Вычисление). 

Знак присваивания изображается как «:=», а вводится при помощи кнопки на панели инструментов Evaluation 
(Вычисление). Слева от знака присваивания указывают имя переменной. Оно может содержать латинские и греческие буквы, 
цифры, а также описательный индекс.  

Переменную, которой присвоено значение, можно использовать далее в документе в вычисляемых выражениях. Чтобы 
узнать значение переменной, следует использовать оператор вычисления.  

Ввод текста. Текст, помещённый в рабочий лист, содержит комментарии и описания и предназначен для ознакомления, 
а не для использования в расчётах. Программа MathCad определяет назначение текущего блока автоматически при первом 
нажатии клавиши ПРОБЕЛ. Если введённый текст не может быть интерпретирован как формула, блок преобразуется в 
текстовый и последующие данные рассматриваются как текст. Создать текстовый блок без использования автоматических 
средств позволяет команда Insert ► Text Region (Вставка ► Текстовый блок).  

Иногда требуется встроить формулу внутрь текстового блока. Для этого служит команда Insert ► Math Region (Вставка 
► Формула).  

Форматирование формул и текста. Для форматирования формул и текста в программе MathCad используется панель 
инструментов Formatting (Форматирование). С её помощью можно индивидуально отформатировать любую формулу или 
текстовый блок, задав гарнитуру и размер шрифта, а также полужирное, курсивное или подчёркнутое начертание символов.   
В текстовых блоках можно также задавать тип выравнивания и применять маркированные и нумерованные списки.  

В качестве средств автоматизации используются стили оформления. Выбрать стиль оформления текстового блока или 
элемента формулы можно из списка Style (Стиль) на панели инструментов Formatting (Форматирование). Для формул и 
текстовых блоков применяются разные наборы стилей.  

Для того, чтобы изменить стиль оформления формулы или создать новый стиль, используется команда Format ► Equation 
(Формат ► Выражение). Изменение стандартных стилей VariabIes (Переменные) и Constants (Константы) влияет на отображение 
формул по всему документу. Стиль оформления имени переменной учитывается при её определении. Так, переменные х и х 
рассматриваются как различные и не взаимозаменяемы.  

При оформлении текстовых блоков можно использовать более обширный набор стилей. Настройка стилей текстовых 
блоков производится при помощи команды Format ► Style (Формат ► Стиль).  

Работа с матрицами. Векторы и матрицы рассматриваются в программе MathCad как одномерные и двумерные 
массивы данных. Число строк и столбцов матрицы задаётся в диалоговом окне Insert Matrix (Вставка матрицы), которое 
открывают командой Insert ► Matrix (Вставка ► Матрица). Вектор задаётся как матрица, имеющая один столбец.  

После щелчка на кнопке ОК в формулу вставляется матрица, содержащая вместо элементов заполнители. Вместо 
каждого заполнителя надо вставить число, переменную или выражение.  



 

Для матриц определены следующие операции: сложение, умножение на число, перемножение и прочие. Допустимо 
использование матриц вместо скалярных выражений: в этом случае предполагается, что указанные действия должны быть 
применены к каждому элементу матрицы, и результат также представляется в виде матрицы. Например, выражение М + 3, где 
М – матрица, означает, что к каждому элементу матрицы прибавляется число 3. Если требуется явно указать необходимость 
поэлементного применения операции к матрице, используют знак векторизации, для ввода которого служит кнопка Vectorize 
(Векторизация) на панели инструментов Matrix (Матрица).  

Например:  
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 – обычное произведение матриц; 

 









−

−
=







 −
⋅







− 12

31
12
11

11
31

 – поэлементное произведение матриц с использованием векторизации.  

 
Для работы с элементами матрицы используют индексы элементов. Нумерация строк и столбцов матрицы начинается с 

нуля. Индекс элемента задаётся числом, переменной или выражением и отображается как нижний индекс. Он вводится после 
щелчка на кнопке Subscript (Индекс) на панели инструментов Matrix (Матрица).  

Пара индексов, определяющих элемент матрицы, разделяется запятой. Иногда (например, при построении графиков) 
требуется выделить вектор, представляющий собой столбец матрицы. Номер столбца матрицы отображается как верхний 
индекс, заключенный в угловые скобки, например М<0>. Для его ввода используется кнопка Matrix Column (Столбец) на 
панели инструментов Matrix (Матрица).  

Чтобы задать общую формулу элементов матрицы, типа Mi,j := i + j, используют диапазоны. Диапазон фактически 
представляет собой вектор, содержащий арифметическую прогрессию, определённую первым, вторым и последним 
элементами. Задавая диапазон, следует указать значение первого элемента, через запятую значение второго и через точку с 
запятой значение последнего элемента. Точка с запятой при задании диапазона отображается как две точки ( .. ). Диапазон 
можно использовать как значение переменной, например х:= 0, 0.01 .. 1.  

Если разность прогрессии равна единице (т. е., элементы просто нумеруются), значение второго элемента и 
соответствующую запятую опускают. Например, чтобы сформировать по приведённой выше формуле матрицу размером 6 × 6, 
перед этой формулой надо указать i:=0 .. 5 j:=0 .. 5. При формировании матрицы путём присвоения значения её элементам, 
размеры матрицы можно не задавать заранее. Всем неопределённым элементам автоматически присваиваются нулевые 
значения. Например, формула M5,5 :=1 создаёт матрицу М размером 6 × 6, у которой все элементы, кроме расположенного в 
правом нижнем углу, равны 0.  

Стандартные и пользовательские функции. Произвольные зависимости между входными и выходными параметрами 
задаются при помощи функций. Функции принимают набор параметров и возвращают значение, скалярное или векторное 
(матричное). В формулах можно использовать стандартные встроенные функции, а также функции, определённые 
пользователем.  

Для того, чтобы использовать функцию в выражении, надо определить значения входных параметров в скобках после 
имени функции. Имена простейших математических функций можно ввести с панели инструментов Calculator (Счёт). 
Информацию о других функциях можно почерпнуть в справочной системе. Вставить в выражение стандартную функцию 
можно при помощи команды Insert ► Function (Вставка ► Функция).  В диалоговом окне Insert Function (Вставка функции) 
слева выбирается категория, к которой относится функция, а справа – конкретная функция. В нижней части окна выдается 
информация о выбранной функции. При вводе функции через это диалоговое окно автоматически добавляются скобки и 
заполнители для значений параметров.  

Пользовательские функции должны быть сначала определены. Определение задаётся при помощи оператора 
присваивания. В левой части указывается имя пользовательской функции и, в скобках, формальные параметры – 
переменные, от которых она зависит. Справа от знака присваивания эти переменные должны использоваться в выражении. 
При использовании пользовательской функции в последующих формулах её имя вводят вручную. В диалоговом окне <Insert 
Function> (Вставка функции) оно не отображается.  

Решение уравнений и систем уравнений. Для численного поиска корней уравнения в MathCad используется функция 
root, служащая для решения уравнений вида f(x) = 0, где f(x) – выражение, корни которого нужно найти, а х – неизвестное. 
Для поиска корней с помощью функции root, надо присвоить искомой переменной начальное значение, а затем вычислить 
корень при помощи вызова функции: root(f(x), x). Здесь f(x) – функция переменной х, используемой в качестве второго 
параметра. Функция root возвращает значение независимой переменной, обращающее функцию f(x) в 0.  

Например:  
х:= 1  
root(2·sin(x) – х,х) = 1.895.  
Если уравнение имеет несколько корней (как в данном примере), то результат, выдаваемый функцией root, зависит от 

выбранного начального приближения.  



 

Если надо решить систему уравнений (неравенств), используют так называемый блок решения, который начинается с 
ключевого слова given (дано) и заканчивается вызовом функции find (найти). Между ними располагают логические 
утверждения, задающие ограничения на значения искомых величин, иными словами, уравнения и неравенства. Всем 
переменным, используемым для обозначения неизвестных величин, должны быть заранее присвоены начальные значения.  

Для того, чтобы записать уравнение, в котором утверждается, что левая и правая части равны, используется знак 
логического равенства – кнопка Boolean Equals (Логически равно) на панели инструментов Evaluation (Вычисление). Другие 
знаки логических условий можно найти на панели Boolean.  

Заканчивается блок решения вызовом функции find, у которой в качестве аргументов должны быть перечислены 
искомые величины. Эта функция возвращает вектор, содержащий вычисленные значения неизвестных.  

Например:  
х:=0 у:=0 
given  
х+у=1  
х2 + у2=4  

find(x,y) = 







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823.1
 

Построение графиков. Для построения двумерного графика в координатных осях ХY, надо дать команду Insert ► 
Graph ► хy Plot (Вставка ► График ► Декартовы координаты). В области размещения графика находятся заполнители для 
указания отображаемых выражений и диапазона изменения величин. Заполнитель у середины оси координат предназначен 
для переменной или выражения, отображаемого по этой оси. Обычно используют диапазон или вектор значений. Граничные 
значения по осям выбираются автоматически в соответствии с диапазоном изменения величины, но их можно задать и 
вручную.  

В одной графической области можно построить несколько графиков. Для этого надо у соответствующей оси 
перечислить несколько выражений через запятую.  

Разные кривые изображаются разным цветом, а для форматирования графика надо дважды щёлкнуть на области 
графика. Для управления отображением построенных линий служит вкладка Traces (Линии) в открывшемся диалоговом 
окне. Текущий формат каждой линии приведён в списке, а под списком расположены элементы управления, позволяющие 
изменять формат. Поле Legend label (Описание) задаёт описание линии, которое отображается только при сбросе флажка Hide 
Legend (Скрыть описание). Список Symbol (Символ) позволяет выбрать маркеры для отдельных точек, список Line (Тип линии) 
задаёт тип линии, список Color (Цвет) – цвет. Список Туре (Тип) определяет способ связи отдельных точек, а список Width 
(Толщина) – толщину линии.  

Для построения простейшего трёхмерного графика, необходимо задать матрицу значений. Отобразить эту матрицу 
можно в виде поверхности – Insert ► Graph ► Surface Plot (Вставка ► График ► Поверхность), столбчатой диаграммы – 
Insert ► Graph ► 3D Ваr Plot (Вставка ► График ► Столбчатая диаграмма) или линий уровня – Insert ► Graph ► Contour 
Plot (Вставка ► График ► Линии уровня).  

Имеются и другие способы отображения трёхмерного графика. 
Аналогичным образом можно построить поверхность, заданную параметрически. Для этого надо задать три матрицы, 

содержащие, соответственно, х-, у- и z-координаты точек поверхности. Теперь надо дать команду построения поверхности 
Insert ► Graph ► Surface Plot (Вставка ► График ► Поверхность) и указать в области графика эти три матрицы в скобках и 
через запятую.  

Диалоговое окно для форматирования трёхмерных графиков также открывают двойным щелчком на области графика.  
Аналитические вычисления. С помощью аналитических вычислений находят аналитические или полные решения 

уравнений и систем, а также проводят преобразования сложных выражений (например, упрощение). Иначе говоря, при 
таком подходе можно получить нечисловой результат. В программе MathCad конкретные значения, присвоенные 
переменным, при этом игнорируются – переменные рассматриваются как неопределённые параметры. Команды для 
выполнения аналитических вычислений в основном сосредоточены в меню Symbolics (Аналитические вычисления).  

Для упрощения выражения (или части выражения), надо выбрать его при помощи уголкового курсора и дать команду 
Symbolics ► Simplify (Аналитические вычисления ► Упростить). При этом выполняются арифметические действия, 
сокращаются общие множители и приводятся подобные члены, применяются тригонометрические тождества, упрощаются 
выражения с радикалами, а также выражения, содержащие прямую и обратную функции (типа elnx). Некоторые действия по 
раскрытию скобок и упрощению сложных тригонометрических выражений требуют применения команды Symbolics ► Expand 
(Аналитические вычисления ► Раскрыть).  

Команду Symbolics ► Simplify применяют и в более сложных случаях. Например, с её помощью можно:  
- вычислить предел числовой последовательности, заданной общим членом;  
- найти общую формулу для суммы членов числовой последовательности, заданной общим членом;  
- вычислить производную данной функции;  
- найти первообразную данной функции или значение определённого интеграла.  
Другие возможности меню Symbolics (Аналитические вычисления) состоят в выполнении аналитических операций, 

ориентированных на переменную, использованную в выражении. Для этого надо выделить в выражении переменную и 
выбрать команду из меню Symbolics ► Variable (Аналитические вычисления ► Переменная). Команда Solve (Решить) ищет 
корни функции, заданной данным выражением, например, если выделить уголковым курсором переменную х в выражении 



 

ах2 + bх + c, то в результате применения команды Symbolics ► VariabIe ► Solve (Аналитические вычисления ► Переменная 
► Решить), будут найдены все корни: 
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. 

 
Имеются и другие возможности использования этого меню (аналитическое дифференцирование и интегрирование, 

замена переменной, разложение в ряд Тейлора и т.д.). 
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